Welcome to eThority

Introduction and Orientation Guide
**What is eThority?**

*eThority* places the power of data analysis into the hands of management. Through the use of our new and progressive user interface, *eThority* enables first time users to engage in **productive** analysis and information mining.

*eThority* allows you to quickly and easily manipulate your core data sets into meaningful structures for reporting, graphing and distribution.

*eThority* was designed from the ground up to deliver value immediately upon implementation. *eThority* stands as a benchmark for ease of use and power in enterprise reporting needs.
Who needs eThority?

**eThority** can provide immediate value to anyone with data analysis and reporting needs. **eThority** allows more of your organization to add value by making your data accessible now!

**eThority** has a progressive disclosure model which means it can quickly be adapted by a new or occasional user, but expand to meet the needs of the more experienced power user.

**eThority** makes use of hierarchical security and a data organization model, allowing for scalability from small departmental use up to enterprise-wide consolidation.
From the eThority home page, click the Help menu item and QuickTutor to play a tutorial that will step you through the basics of the application.
eThority Home Page

From the eThority home page, click the **Configure** menu item, **User Settings** and **Change Password** to change the password and/or user login.
eThority Home Page

From the eThority home page, you can format your workspace to suit your needs. Click the **Window** menu item and then **Workspace**.

Select one of the many options for default display settings.

OR

Manually resize, close or move individual panels as needed.
eThority Home Page - DataBooks

- Allows you to make full use of the information resources of your organization.
- You can go from raw data to polished output within minutes.
- Rapid page navigation tools allow you to browse thousands of data pages, containing millions of rows, with the simple glide of a mouse.
- You can create reporting jobs and schedule their distribution via your enterprise e-mail service or within the eThority notification system.
- Integrated security and compliance let you restrict access and set expiration periods for reporting jobs.
eThority Home Page - DataBooks

Folders are groupings of DataBooks that contain a common theme. As you work in eThority, you will learn to quickly and easily define new DataBooks from root or template DataBooks.

When you click a folder, a list of the existing DataBooks is displayed. Click in the upper right hand corner to show all DataBooks in list format.
eThority Home Page - Dash

- The advanced visualizations of Dash makes it easy for users of all skill levels to get involved.

- Drill down to transaction level detail for greater discovery and insight.

- Make and publish changes instantly to your dashboard.

- The Dash alert system creates static thresholds and formula based alerts to make sure you never miss critical notifications.

- What-if variables can be created to affect the data presented in the dashboard in real time.
Double click on a Dash icon to open the dashboard.

Click on any element of the dashboard to interact with the data or drill down to DataBook detail.
eThority Home Page - Favorites

Come straight to your favorites for your day to day eThority workings.

Drag and drop any DataBook, Dash or favorite eThority application link into the Favorites panel to create a list of favorites for ease of use.
- Rename a folder or sub-folder by right clicking and selecting **Rename**.

- Remove a DataBook from your favorites by right clicking and selecting **Delete**.

- Remove a folder by right clicking and selecting **Cut Object**.

- Add a new folder by clicking the middle icon in the upper right corner.
The DataBook

The Data Tab
Navigation
Grouping
Column Header Functions
Sorting
Filtering
Field Selector
The DataBook

A DataBook is a visual representation of your data. Using a DataBook you can sort, group, filter and total your data. You can manipulate your core data sets into meaningful structures for reporting, graphing and distribution.
eThority allows you to quickly navigate through thousands of rows of data. In the lower right corner of this example, you can see that we have 379,343 rows of data.

On bottom middle of the screen, the left or right arrow next to the page number moves you through the pages of data.

Enter a specific page number and click the arrow to load the data for that page.

You can also change the font size of the data by clicking the Zoom on the bottom left.
Navigation

To navigate through your data, click on the **SwiftSeek** handle on the left side of the screen. You can browse thousands of data pages, containing millions of rows. Drag your mouse over the listing to locate your page. Click on the row to load the page.

If there are more than 100 pages in the DataBook, **SwiftSeek** creates regions to mark additional 100 page groups.

Click a region to move to the data surrounding that 100 page group.
To begin simply drag and drop the column header that you want to group into the Group panel at the top of the tab.

A Refresh Needed watermark is displayed across the DataBook.

Click the Refresh button.

To un-group data, drag the desired column header from the Group panel and drop over the rows of data.

Click the Refresh button again.
Grouping

Left click the green arrow, changing the direction to up or down, to sort your groups in ascending or descending order. Right click the green arrow to select **Summary Only** for a listing of your groups. Summary will show only the lowest level group data.
Grouping

To create sub-groups, drag and drop additional column headers into the **Group** panel.

When grouping by a date column, the option of grouping in different time increments is presented.
Grouping

To expand or collapse each group, click the +/- button next to each row or group to open or close a single group.

Beneath the **Refresh** button, click the + to Expand or the – to Collapse. This opens or closes *all* groups at once.
An alternative to dragging the column name up from the DataBook is to click the **Group** button in the Grouping Panel. From here, drag and drop or double click from a list of all columns within the DataBook.
Column Header Functions

To use the **Column Header Functions**, right click on the column header to display the available measures and click to select. You will see the result of the measure in the Grand Total and at all Group levels. To remove a measure, click **No Measure**.

**View Info:** Displays field information pertaining to this column of data.

**Sum:** Adds all numerical entries in the column.

**Average:** Finds the average for numerical entries in the column.

**Percent:** Determines what percentage of entries that group holds out of the entire column.
Column Header Functions

To use the **Column Header Functions** your data must be grouped. Right click on the column header to display the available functions.

**Minimum:** Finds the smallest number in a column of numerical entries. For non-numerical entries it finds the first entry alphabetically in the column.

**Maximum:** Finds the largest numerical entry in the column, or the last alphabetically in the column for non-numerical entries.

**Distinct Count:** Finds the total number of unique entries in the column.

**Count:** Finds the total number of entries in that column.

**No Measure:** This will clear any function set under a column header.
**Column Header Functions**

**Detail Only:** Column data will only be displayed at the detail level and not on the group level.

**Group Only:** Locks the calculation at the group level.

This is particularly helpful if you wish to show average salary data (for example), but not detail of individual salaries.

**Always Show:** Shows the column at the group level and the detail level.

If multiple values exist in the grouping then `<Multiple>` will be displayed.
Column Header Functions

Select a function and click the Refresh button to show changes.

You will see Sums, Averages, Minimums, Maximums and Counts listed for each group the DataBook is divided into and a grand total.
Data will sort from A to Z or from smallest to largest if the column contains numerical entries.

Right click on the column header in the Sort panel to change the sort order from Z to A or click the green arrow on the column header in the Sort panel to change the sort order.
Sorting

Add additional column headers to be sorted to the **Sort** panel. Data will sort in the order that the fields are placed in the **Sort** panel. Sort obeys the following order of Group and Sub-groups and then Sort and any Sub-sort.
Filtering

Use the Filter panel to place limits on the data that appears in the DataBook. Drag and drop any column header to the Filter panel to open the Filter Builder dialog box or click the Filter button to select from a field listing.

To change a filter, double click on the filtered column header you would like to edit in the Filter panel. The Filter Builder window will open.

To remove a filter from the DataBook, drag and drop that column header from the Filter panel. Click the Refresh button.
In this example, the City column header is placed in the **Filter** panel and the **Pick List** Value option has been selected.

The **Pick List** is a list of all unique values contained in the column. The Pick List option is only available for columns of the List data type.

To select cities to be included in the DataBook, click the name of the cities in the right hand box.

To exclude these cities from the DataBook, click the **Exclude These from Result Set** check box on the left below selected cities.

To go to a specific city on the list, click anywhere in the **Select Multiple Items** grid and begin typing.
In this example, the Is Enrolled column header is placed in the Filter panel and the Data Field Value option has been selected.

From the operator dropdown, select the desired option. From the Field dropdown, you may select another data column to compare to.

In this example, we are selecting for only those rows where these two columns match.
Filtering – Text Fields

In this example, the State column header is placed in the Filter panel and the User Value option has been selected.

Type the value directly into the field supplied. Use the dropdown to qualify the search value.
Filtering – Date Fields

In this example, the Transaction Date column header is placed in the **Filter** panel.

**In Range:** To select a range of dates to be included in the DataBook, select and enter the **From** and **To** dates in the fields provided in the **Value** panel.

**In Last, In Next, Prior, Current or Next:** To filter on a day, week, month, quarter, year or fiscal Year. These options change with the **Date Portion** selected in the **Data Field** panel.

**Is Empty:** To include all rows that do not contain any date.

**Exclude These from Result Set:** To exclude the dates selected.
Filtering – Numeric Fields

In this example, the Actual Amount column header is placed in the Filter panel.

**In Range:** To select a range of salaries to be included in the DataBook. Enter the From and To numbers in the fields provided in the Value panel.

**Top(x)% or Bottom(x)%:** To include only the highest or lowest percentage of values of the column in your DataBook. Enter the percentage in the field provided in the Value panel.

**Top(x) Rows or Bottom(x) Rows:** To include only a specified number of rows either from the top or the bottom of the list. Enter the number of rows in the field provided.

**Exclude These from Result Set:** To exclude the range, percentage or rows entered.

**Data Field:** To filter the Actual Amount based on another column in the DataBook. Select the Data Field value option and select the appropriate column from the Field dropdown.
Filtering – On Group Totals

Apply to Group Totals: When filtering on Numerical data that has been grouped and contains functions on the column headers (sum, average, count, etc.), you have the option of filtering by the numbers generated by the functions.

In this example, data is grouped by Department, and the Average function is placed on the Expense column, checking the Apply to Group Totals box in the Filter Builder will allow you to filter based on averages for the departments.
Filtering – Restrictive

When you add a filter, each consecutive filter is restricted by the pre-existing filters. In this example:

The first filter on the City column excludes all cities except Chicago and Denver.

The second filter restricts the DataBook to all salaries in Chicago and Denver that are between 100,000 and 200,000 dollars.

The third filter is now restricted to any of the personnel in Chicago or Denver that make between 100,000 and 200,000 and then it further excludes those who are more than 50 years old.
View Menu Option

Field Selector
Tabs
Reset
User Preferences
The Available Fields grid contains all columns that may be applied to this DataBook. The Current DataBook Fields grid contains all columns currently displayed in the DataBook.

**Add Field/Add All:** To add highlighted fields or all fields to DataBook. A double click on the column name will also move it to the Current DataBook Fields grid.

**Remove Field/Remove All:** To remove columns from the current DataBook.

**Display Text:** Click in the field and type a new name to rename the column in the DataBook.

**Move Up/Move Down:** Reposition the column in the DataBook. You may also drag and drop a field to another position.

**Hide:** Check the box to allow the field for use in a filter, group or sort but to hide it from view as a column in the DataBook.
View – Tabs

Click on any **Tab** option to toggle the checkmark on or off. If it is not checked, the tab will not show as an option in the DataBook.
View – Reset

**Reset Column Widths:** Returns all column sizes back to the default.

The default is the longest value within the data or the header.

**Reset All:** Returns all columns sizes back to the default.

Reset All also removes all groups, sorts, filters and column functions.
User Preferences allows you to apply some defaults to the current DataBook.

**Show Grand Total:** Display a grand total of any calculated field. Check the box if a grand total is desired.

**Freeze Grand Total on Data Tab:** Continue to show the Grand Total while scrolling through data.

**Extend Last Column to Full Page Width:** When the DataBook columns do not extend the entire width of the screen, check the box to enlarge the column to the remaining width of the page. Do not check the box to have the last field of the DataBook retain the default size of the field.
View – User Preferences

Show Empty Columns in Summary Mode: When un-checked, only the columns containing data from Column Header Functions or that are defined as “Always Show” will be displayed when there is a Group defined as Summary.

Allow Filters to be Subgrouped: This allows for advanced grouping of filters on this DataBook.

Filters are Restrictive: When checked each consecutive filter is restricted by the pre-existing filters.

Page Size: Define the number of rows displayed in a single DataBook page, from 100 to 20,000.
PowerFields Menu Option

eXpression Substitution Margin Tabulator

Ranking Percent of Total Benchmarks Control Values
PowerFields allow you to extend the data. With PowerFields you may apply formulas to the data and specify the condition under which they occur.

The results of the PowerField calculation are displayed in a new column. This column is color coded to maintain a delineation between imported data (original) and data that has been acted upon.
PowerFields

Click **Edit PowerFields** to edit any existing PowerField or add a new one of any type.

Use the **Add** options to quickly add a specific type of PowerField.
PowerFields - eXpression

Add: Add a new expression.

Duplicate: Add a new expression based on the expression currently highlighted in the grid on the left.

Edit: Edit the currently highlighted expression in the grid on the left.

Delete: Delete the currently highlighted expression in the grid on the left.

Field Name: This will be the header name for the new column that will contain the results of the expression.

Data Type: Determines how the data will be displayed. See following page for definitions.
PowerFields – Data Types

From the **Data Type** dropdown, select how the data in the expression should be displayed.

**Currency**: Displays numerical data with two digits after the decimal, and will round to the nearest two digits if more exist. **Example** 1.73

**Date**: Displays data in a date format. **Example** mm/dd/yyyy

**Decimal**: Displays numerical data with all available digits displayed after the decimal point. **Example** 1.734628937

**Freeform**: Displays data exactly as it has been entered. Data is treated as non-numerical. **Example** 5x7w5p

**Integer**: Displays numerical data as a whole number. If digits exist beyond the decimal point, they will be rounded to the next whole number. **Example** 1.743 becomes 2

**List**: Data will be available in a pick list format when filtered.

**Percent**: Displays numerical data in a percentage format. **Example** .74 becomes 74%

**Year**: Displays four digit numerical data as a year.

**Yes/No**: Displays data in a yes or no format such that a 0 becomes a No and a 1 becomes a Yes.
PowerFields - eXpression

Click the **Edit** button under **Use this Expression** to open the eXpression builder.

The grid on the left contains all the columns of the DataBook. Double click or drag and drop to place them in the panel on the left.

Constants may also be added to the formula by entering a **Custom Value** or selecting a predefined value from **Math Value** or **Date Value** in the User Values box on the bottom left.

When two fields have been placed into the expression the operator drop down is displayed.
**PowerFields - eXpression**

**Group:** Combines highlighted elements together for complex calculations. Click each element to highlight then click **Group**.

**Un-Group:** Removes the grouping.

**Move Up / Move Down:** Change the placement of elements or groups. Click to select the element then click the appropriate **Move** button.
**PowerFields - eXpression**

**Function:** Apply date, numeric or alpha-numeric functions to any element of the expression. Click the element, click **Function** and then select the appropriate function. Date, Math or String functions are displayed depending on the data type of the element.
PowerFields – Math Functions

Math functions are available for data elements defined as integers, decimals, percentages or currency data type. They return numerical values.

None: Selecting this option will remove any function previously placed on the data element.

Square Root: Applies a square root to data in this field.

  Example  The square root of 36 returns the value 6

Squared: This option will square the number, or take it to the second power.

  Example  2 squared returns the value 4

To Power X: Applies an exponential value to the value in this field.

  Example  To Power 4 takes the value 2 to the fourth power returning the value 16
**PowerFields – Math Functions**

**Round**: This option will round the data in this field to the nearest whole number.

  *Example*  2.75 rounds up to 3 and 2.2 rounds down to 2

**Round Up**: This option will round the data in the field UP to the next whole number.

  *Example*  Both 2.75 and 2.2 round up to 3

**Round Down**: This option will round the data in this field DOWN to the next whole number.

  *Example*  Both 2.75 and 2.2 round down to 2

**Absolute Value**: Measures how far numerical data entries are from zero, thereby eliminating negative numbers.

  *Example*  Both 3 and -3 return an absolute value of 3

**Sine/Tangent/Arc Sine/Arc Cosine/Arc Tangent/Natural Log**: These options return the specified value of the data in this field.
PowerFields – String Functions

String functions are available for data elements defined as **String** or text data type. This may be non-numerical data or a number with no numerical significance, for instance the number on a basketball player's jersey or a student id number.

None: Selecting this option will remove any function previously placed on the data element.

**Upper Case (ABC):** This option will convert any text in the field to all capital letters.

  Example  John Smith returns JOHN SMITH

**Lower Case (abc):** This option will convert any text in the field to all lower case letters.

  Example  John Smith becomes john smith

**Proper Case (Abc):** This option will convert the first letter of any word into a capital letter and make the remaining letters lower case.

  Example  johN SMITH becomes John Smith
**PowerFields – String Functions**

**Trim Spaces:** This option removes all spaces between words or characters.

*Example*  
John Smith becomes JohnSmith

**First (x) Characters:** This option displays only the first "x" number of characters in that entry.

*Example*  
The First 3 Characters of a phone number takes 843-556-5565 and returns 843

**Last (x) Characters:** This option displays only the last "x" characters in that entry.

*Example*  
The Last 7 Characters of Customer ID information takes 0001374829 and returns 1374829

**Middle (y) Characters Start at Position (x):** This option starts "x" characters into the entry and returns "y" number of characters.

*Example*  
The Middle 3 Characters Start at Position 5 of a phone number takes 843-556-5565 and returns 556
PowerFields – String Functions

**Convert to Number:** This takes numerical data previously categorized with a Freeform or String data type and converts it to a number. This allows it to be used for numerical calculations.

**Convert to Date:** This takes a date previously categorized with a Freeform or String data type and converts it to a date. This allows it to be used for date calculations.
PowerFields – Date Functions

Date functions are available for data elements defined with a Date data type.

None: Selecting this option will remove any function previously placed on the date element.

Get Day (Number): Pulls the day out of a full date entry.
   Example  6/28/2010 or June 28, 2010 returns 28

Get Month: Pulls the month out of a full date entry.
   Example  6/28/2010 or June 28, 2010 returns 6

Get Year: 2 Digit (Number): Pulls the year out of a full date entry as a two digit number.
   Example  6/28/2010 or June 28, 2010 returns 10

Get Year: 4 Digit (Number): Pulls the year out of a full date entry as a four digit number.
   Example  6/28/2010 or June 28, 2010 returns 2010
**Convert to String (‘01/01/09’):** Converts the date into a mm/dd/yy format and removes the “date” functionality so that the data will be treated as a string.

**Example**  June 28,2010 or 6/28/2010 returns “06/28/10”

**Convert to String (‘01/01/2009’):** Converts the date into a mm/dd/yyyy format and removes the “date” functionality so that the data will be treated as a string.

**Example**  June 28,2010 or 6/28/2010 returns “06/28/2010”

**Convert to String (‘Jan 1, 2009’):** Converts the date into a month date, year format and removes the “date” functionality so that the data will be treated as a string.

**Example**  June 28,2010 or 6/28/2010 returns “June 28, 2010”
PowerFields – Date Functions

Adjust (x) Days: Enter the number of days to add or subtract from the date.


Adjust (x) Months: Enter the number of months to add or subtract from the date.


Adjust (x) Years: Enter the number of years to add or subtract from the date.


Last Day of Month: Returns the last day of the month of the date.

Example  6/28/2010 returns 6/30/2010
**PowerFields – Date Functions**

**Last Day of Quarter:** Returns the last day of the quarter of the date.
   - **Example**  10/28/2010 returns 12/31/2010

**Last Day of Year:** Returns the last day of the year of the date.
   - **Example**  10/28/2010 returns 12/31/2010

**Day (x) of Month:** Returns the requested day of the month of the date.
   - **Example**  Day 15 of Month for 6/28/2010 returns 6/15/2010

**Day (x) of Quarter:** Returns the requested day of quarter of the date.
   - **Example**  Day 1 of Quarter for 11/28/2010 returns 10/01/2010

**Day (x) of Year:** Returns the requested day of the year of the date.
   - **Example**  Day 15 of Year for 10/28/2010 returns 1/15/2010
PowerFields - eXpression

Right click an element to apply Measure functionality to the expression. This allows for calculations using group and total amounts to be applied at row level.

**Sum-Group:** Returns the sub-total amount of the column for each group.

**Average-Group:** Returns the average amount of the column for each group.

**Maximum-Group:** Returns largest numerical entry or the last alphabetically in the column for each group.

**Minimum-Group:** Returns the lowest numerical entry or the lowest alphabetically in the column for each group.

**Count-Group:** Returns the total row count in the group.

**Sum-Total:** Returns the grand total amount of that column in the DataBook.

**Average-Total:** Returns the average amount of the column in the DataBook.

**Maximum-Total:** Returns largest numerical entry or the last alphabetically in the column in the DataBook.

**Minimum-Total:** Returns the lowest numerical entry or the lowest alphabetically in the column in the DataBook.
Placing **Sum-Group** on the Actual Amount element returns the total amount of the group for each row. **Sum-Total** returns the grand total on each row.
In this example, we are using **Sum Total** to calculate the percent of total spending in department 00720 for each project and account.

The eXpression is Actual Amount / Actual Amount (**Sum-Total**).

Our first row, Project 5649, determines “Percent of Spending” for Books expense by using the calculation: 99 / 4,424.23 = 0.02238.

The **Data Type** is set to **Percent** so that our result is displayed as 2.238%

By placing a **Sum** measure on the Percent of Spending column, we see that the percent of spending for Books in the department is 42.920%.
PowerFields – eXpression

When the expression is complete, click the **OK** button to return to the Add PowerField dialog.

To place a condition under which the expression should be applied to each row, click the **Edit** button under **For these Records**.

The Condition Builder is displayed.
PowerFields - eXression

Drag and drop or double click fields to create a conditional filter.
Multiple expressions and conditions may be added using + Expression button in the lower left corner. Click on an expression and then click the Trashcan button to delete.

In this example:

Actual Amount is being multiplied by .10 for all rows where the Account Class is either an Expense or a Travel Expense.

For the rows where the Account Class is Payroll Expense the Actual Amount is multiplied by .05.

Leave the For These Records blank to apply the expression to all rows.

When the expression is complete, click the Test button. Then click Save. Click Add to add another expression or OK to return to the DataBook.
PowerFields - eXpression

To view the results of your expression, click **Refresh** on the DataBook. The results are displayed in a new column at the far right.

The new column may be acted upon in the same manner as any other data column. It may now be sorted, filtered or grouped. You may apply Column Header functions or use it in other expressions.

Expression columns are shaded yellow to distinguish them from data columns originating in the source system.

<table>
<thead>
<tr>
<th>Center Name</th>
<th>Account Class</th>
<th>Actual Amount</th>
<th>Projected Spend Incr</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Payroll Expenses</td>
<td>$251.57</td>
<td>$264.15</td>
</tr>
<tr>
<td></td>
<td>Payroll Expenses</td>
<td>$66.13</td>
<td>$63.14</td>
</tr>
<tr>
<td><strong>Total for Department: 00411</strong></td>
<td></td>
<td><strong>$311.70</strong></td>
<td><strong>$327.29</strong></td>
</tr>
<tr>
<td></td>
<td>Expenses</td>
<td>$186.53</td>
<td>$196.58</td>
</tr>
<tr>
<td></td>
<td>Expenses</td>
<td>$136.91</td>
<td>$144.00</td>
</tr>
<tr>
<td></td>
<td>Expenses</td>
<td>$26.00</td>
<td>$22.00</td>
</tr>
<tr>
<td></td>
<td>Expenses</td>
<td>$32.49</td>
<td>$35.74</td>
</tr>
<tr>
<td></td>
<td>Expenses</td>
<td>$348.81</td>
<td>$383.69</td>
</tr>
<tr>
<td></td>
<td>Expenses</td>
<td>$14.99</td>
<td>$16.49</td>
</tr>
<tr>
<td></td>
<td>Expenses</td>
<td>$206.00</td>
<td>$226.60</td>
</tr>
<tr>
<td></td>
<td>Expenses</td>
<td>$47.76</td>
<td>$52.54</td>
</tr>
<tr>
<td><strong>Total for Department: 00404</strong></td>
<td></td>
<td><strong>$981.49</strong></td>
<td><strong>$1,079.64</strong></td>
</tr>
</tbody>
</table>

Note in this example that the calculation against the rows with an Account Class of Payroll Expenses is (Actual Amount * .05) + Actual Amount. The calculation against rows with an Account Class of Expense is (Actual Amount * .10) + Actual Amount.

This is in keeping with the conditions placed on the expression.
PowerFields - Substitution

The Substitution PowerField is used to create a new column, in which the value in the original column is replaced with a specified new value.

For example, a column in this DataBook contains the full or part time status of an employee. In the source system this field is described as F – Full Time and P – Part Time. Use the Substitution PowerField to simplify the data to F or P.
**PowerFields - Substitution**

**Field Name:** This will be the header name for the new column that will contain the results of the expression.

**Data Type:** Determines how the data will be displayed. See PowerFields – Data Types for definitions of the different data types.

**Source Column:** Select the original column of data to be substituted.

**Collect Unique Values:** Each unique value from the source column will be displayed.

In the **Substitution Value** column, enter the corresponding value to be displayed.
PowerFields - Margin

The Margin PowerField contains several pre-defined expressions - Margin, Markup, Difference and Ratio.

**Field Name:** This will be the header name for the new column that will contain the results of the expression

**Type:** Select a pre-defined expression.

**Column 1:** Select from all columns that are defined as numeric within the current DataBook.

**Column 2:** Select from all columns that are defined as numeric within the current DataBook.

**Decimal Result:** Select to view result in decimal format.

**% Result:** Select to view result in percent format.
PowerFields - Margin

**Margin**: Subtracts column 2 from column 1 and divides that total by column 1.

**Example**  Calculate profit margin where Column 1 = Sales Price  Column 2 = Cost
(Sales Price – Cost) / Sales Price  or  (374.38 – 359.38) / 374.38 = 0.040 or 4.007%

---

**All expressions in the Margin PowerField are weighted.** The group totals are calculated using the Margin formula. In the Profit Margin column the group total is the Margin of Total Cost and Total Sales Price rather then a sum of all numbers in the Profit Margin column.
PowerFields - Margin

**Markup:** Divides column 1 by column 2 and subtracts 1.

**Example**  
% of price change where Column 1 = New Price and Column 2 = Original Price  
\[(\text{New Price} / \text{Original Price}) - 1\]  
or \[(53.00 / 38.00) - 1 = .395\text{ or } 39.474\%\]

---

<table>
<thead>
<tr>
<th>Original Price</th>
<th>New Price</th>
<th>Markup</th>
</tr>
</thead>
<tbody>
<tr>
<td>$38.00</td>
<td>$53.00</td>
<td>0.395</td>
</tr>
<tr>
<td>$95.66</td>
<td>$110.66</td>
<td>0.156</td>
</tr>
<tr>
<td>$70.04</td>
<td>$85.04</td>
<td>0.214</td>
</tr>
<tr>
<td>$34.10</td>
<td>$49.10</td>
<td>0.441</td>
</tr>
<tr>
<td><strong>$237.80</strong></td>
<td><strong>$297.80</strong></td>
<td><strong>0.252</strong></td>
</tr>
</tbody>
</table>

**Decimal Result**

<table>
<thead>
<tr>
<th>Original Price</th>
<th>New Price</th>
<th>Markup</th>
</tr>
</thead>
<tbody>
<tr>
<td>$38.00</td>
<td>$53.00</td>
<td>39.474%</td>
</tr>
<tr>
<td>$95.66</td>
<td>$110.66</td>
<td>15.025%</td>
</tr>
<tr>
<td>$70.04</td>
<td>$85.04</td>
<td>21.425%</td>
</tr>
<tr>
<td>$34.10</td>
<td>$49.10</td>
<td>44.118%</td>
</tr>
<tr>
<td><strong>$237.80</strong></td>
<td><strong>$297.80</strong></td>
<td><strong>25.210%</strong></td>
</tr>
</tbody>
</table>

**% Result**

*All expressions in the Margin PowerField are weighted.* The group totals are calculated using the Markup formula.
**PowerFields - Margin**

**Difference:** Subtracts column 2 from column 1.

**Example**  Price difference where Column 1 = New Price and Column 2 = Original Price  
New Price - Original Price or  515.00 - 500.00 = 15.00
**Ratio:** Divides column 1 by column 2.

**Example**  In a DataBook containing population information including the number of females and males in each county, find the female to male ratio for each county.

Column 1 = the number of females and Column 2 = number of males

Number of Females / Number of Males  or  12,552 / 11,310 = 1.109

There are 1.109 females to each male in Abbeville County.
PowerFields - Tabulator

The Tabulator PowerField calculates either a running total or the amount of change from row to row.

**Field Name:** This will be the header name for the new column that will contain the results of the expression.

**Type:** Select to see a cumulative row total or the amount of change between the rows.

**Column:** Select the column of data to be tabulated.
In this example, the Actual Amount column is being tabulated for a running total in the Amount Run Total column.

In the Amount Change column, the amount of change is calculated and an up arrow indicates an increase from the previous row or group and a down arrow a decrease.
**Field Name:** This will be the header name for the new column that will contain the results of the expression.

**Column 1:** Select the column of data to be ranked from all columns that are defined as numeric within the current DataBook.

**Order:** Select to rank in ascending or descending order.

<table>
<thead>
<tr>
<th>County</th>
<th>Population</th>
<th>Males</th>
<th>Females</th>
<th>Females Ranking</th>
<th>Males Ranking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spartanburg</td>
<td>226,800</td>
<td>109,230</td>
<td>117,570</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Lexington</td>
<td>167,611</td>
<td>81,668</td>
<td>85,943</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Anderson</td>
<td>145,195</td>
<td>69,436</td>
<td>75,760</td>
<td>6</td>
<td>7</td>
</tr>
<tr>
<td>Horry</td>
<td>144,053</td>
<td>70,516</td>
<td>73,537</td>
<td>7</td>
<td>6</td>
</tr>
<tr>
<td>York</td>
<td>131,497</td>
<td>63,181</td>
<td>68,316</td>
<td>8</td>
<td>9</td>
</tr>
<tr>
<td>Berkeley</td>
<td>128,776</td>
<td>64,972</td>
<td>63,804</td>
<td>9</td>
<td>8</td>
</tr>
<tr>
<td>Aiken</td>
<td>120,940</td>
<td>58,596</td>
<td>62,344</td>
<td>10</td>
<td>10</td>
</tr>
</tbody>
</table>

In this example, one column contains the rank order of males and one that of females so that they may be compared per county. While Anderson ranks 6 in the number of females, they rank 7 in the number of males.
Field Name: This will be the header name for the new column that will contain the results of the expression.

Column: Select the column of data to view as percent of total.

Calculating against the Amount column, the Amount Pct of Total shows the percentage for each Quarter (group) of the grand total.
PowerFields - Benchmark

Use this function to compare performance of numerical values to standards set by your industry or organization.

In the Available Fields grid on the left are all numeric values that can be set as a benchmark. Highlight the desired field and click **Add Benchmark**.

The field is added to the Active Benchmark grid on the right. In the **Benchmark Value** field enter the benchmark amount.

Click **OK** to save the benchmark and return to the DataBook.
PowerFields - Benchmark

Benchmark values may now be used in filter options, in eXpressions or viewed as eValuate comparisons.
Control Values give the creator of the DataBook the ability to build complex filters or expressions that may be locked down and the end-user prompted for only specific values. The end-user is prompted for all the control values on opening the DataBook.

Control Values allow you to create end-user defined parameter value(s) for a DataBook filter or eXpression. Click **Add** to add a parameter.
Control Value: Type the prompt to be presented to the end-user on entering the DataBook.

Data Type: Click the field to open the dropdown. Select the data type appropriate to the end-user response.

Column: If data type is DataBook Column, select the appropriate DataBook column. The values from the column selected here will be presented to the end-user for selection. If any other data type is selected this field will remain blank.

Value: Enter a default control value. The end-user may edit this value on entry to the DataBook. If this value is a DataBook Column data type, the field will contain an ellipses button. Click the button to select a value from a list of the column values. Otherwise enter a value directly into the field.

Click **OK** to save the Control Values and return to the Databook. Click **Refresh**.
PowerFields – Control Values

Using Control Values in Filters:
Drag the column used in the Control Value to the Filter panel.

Click the Operator dropdown and select the appropriate operator for the filter.

Select the Data Field value option.

From the Field dropdown, scroll to the bottom to find all Control Value options in bold red text.

When the DataBook is saved, select Ask for Control Values to display the Control Values prompt each time the DataBook is opened.
PowerFields – Control Values

Using Control Values in Filters:

When the DataBook is opened the Control Values prompt will be displayed. You may enter a new value by picking from a list or typing directly into the field.

When the DataBook opens it will be pre-filtered based on the value selected.
PowerFields – Control Values

Using Control Values in Expressions:

When creating an expression, the Control Values are displayed as a value in the Column Name options and may be added to the expression.

The value of the field is determined by the end-user on opening the DataBook.

(see PowerFields – Expressions for more information on expressions)

When the DataBook is saved, select Ask for Control Values to display the Control Values prompt each time the DataBook is opened.

The end-user may change the value of the Control Value by clicking on the PowerFields menu option and selecting Enter Control Values. This option is only available when there are Control Values configured.
File Menu Options

- Save and Save As
- Print
- Export
- Send
Click **File** on the toolbar at the top left of the screen. Select a **Save** option from the File menu.

**Save:** To update the existing DataBook. This option will save any changes over the version that was opened.

**Save As:** To create a new DataBook. This will keep a revised copy of the DataBook along with the original.

**Name:** Enter the DataBook name to be displayed in the Library.

**Description:** Include a brief summary of your DataBook in this field if desired.
**Auto-Refresh Grid:** The DataBook will auto-refresh every time a change is made in the DataBook, for instance, edits in **Group**, **Sort** or **Filter** panel, etc.

**Expand All Groups:** Presents all data in Groups in expanded format on opening the DataBook.

**Prevent Overwrite:** Requires users who wish to save a derivative of this DataBook to save it under a new name.

**Default View:** Select which tab the DataBook opens to when it is reopened – Data, Graph, Evaluate or SuperPivot.
File – Save and Save As

Click the **Sharing** button to determine who will have access to this DataBook.

**REMEMBER** It is only the shaping and format of the DataBook that is shared. The content is based on the user rights – organizationally and through assignment of roles.

**Global:** The DataBook will be available to all eThority users.

**Department:** Specify an area within the organizational structure to have access to this DataBook.

**User:** Select specific users or groups of users who can access to this DataBook.

**Prevent Send:** Do not allow this DataBook to be distributed via the Send functionality in eThority.

**Prevent Export:** Do not allow this DataBook to be exported using the eThority export option.
**File – Save and Save As**

**Keywords** allows you to assign keywords to your DataBook for use in future searches. Double click on a keyword from the dictionary or highlight and click the **Add** button.

To add a new keyword, click **New Keyword** button.

The Keywords dialog is displayed. Click **Add** and enter your new keyword and description. Click **Save**.

Your new keyword is now an option in the Keyword Dictionary.
File – Save and Save As

Click the **Library** button to select the folder location where you would like the DataBook to be displayed.

Click the **Author/Notes** button to add comments pertaining to this version of the DataBook. Share specific details of the DataBook to share with other users. Add a date to your notes by clicking the **Data Stamp** button. This will provide context for your comment, particularly in DataBooks where the data is updated frequently.
Click Print from the File menu and then click OK to print a PDF version of the DataBook.

To export to a variety of formats, click Export on the File menu.

From the Format dropdown select the desired format and click OK.
Click **Send** from the **File** menu to Schedule the DataBook for automatic distribution.

**Report Name:** Edit the report name if applicable.

**Subject Line:** Enter a brief summary of your message.

**Email/Write To File:** Select the desired output. Write to File follows the same process as exporting a DataBook.

**File Format:** From the dropdown select the desired format option in which to send the report.

**Don’t send empty reports:** Select this option to prevent blank DataBooks from being distributed.
File – Send and Schedule

On the Recipients tab, enter the email addresses of the recipients of the DataBook.

**Add eThority User:** Select from a list of existing eThority users. The Email Address field will automatically populate. The distributed DataBook will be filtered based on the user’s rights within eThority.

**Add non eThority User:** Enter the email address directly into the Email Address field.

**CAUTION** – when a DataBook is sent to someone outside of eThority, the report will be filtered based on the sender’s rights.

**Add Group:** Select a predefined group of eThority users.
To set a schedule for distribution, click the ellipsis button next to the **Selected Schedule** field. To select from a list of predefined schedules click **Yes**. Then highlight the desired schedule and click **OK**.
File – Send and Schedule

To create your own schedule click No.

**Frequency:** Determines the interval at which the DataBook will be sent.

**Duration:** Determines duration of schedule.

**Processing Window:** Set the DataBook to run at specific times of the day to manage processing demands that may impact system performance.
Select the **Frequency** interval from the dropdown options to determine how often the DataBook will be sent.

**Now**: This option will send the DataBook immediately.

**Once**: In the **Starting** date field, enter the date for one-time delivery of the DataBook.

**Minute**: Select the interval for the number of minutes at which you would like the DataBook sent out.

**Hour**: Select the interval for the number of hours at which you would like the DataBook sent out.
File – Send and Schedule

**Day:** Select the interval for the number of days at which you would like the DataBook sent out. Or click **Weekday** to send the DataBook every day, Monday through Friday.

**Example**  The DataBook scheduled below will be delivered every 10 days.

![Screenshot of frequency selection for days]

**Week:** Select the interval for the number of weeks at which you would like the DataBook sent out. Choose the day of delivery by clicking in the box to the left of the desired day.

**Example**  The DataBook scheduled below will be delivered every 2 weeks. It will arrive on the Sunday of the 1st and 3rd week of the month.

![Screenshot of frequency selection for weeks]
**File – Send and Schedule**

**Month:** Select the week of the month from the first drop-down list. Select the day of the week from the second drop-down list, and the frequency for DataBook delivery in the third box. Or click the second option and enter the exact day of the month for delivery.

**Example**  The DataBook scheduled below will be delivered every 3 months. It will arrive on the Monday of 3rd month.

![Frequency - Month](image)

**Annually:** Select the week of the month from the first dropdown, the day of the week from the second, and the month of delivery from the last dropdown menu. Or click the second option to enter the exact numeric (Julian) day of the year for delivery.

**Example**  The DataBook scheduled below will be delivered on the first Monday of April.

![Frequency - Annually](image)
Once a frequency has been selected, specify the **Duration** of the schedule.

**Starting**: Begin delivery of DataBook starting on this date.

**Ending**:

- **Never**: Continue to deliver indefinitely.
- **On this Date**: Continue delivery based on the frequency until the specified date.
- **Occurrences**: Deliver the report a specified number of times.
Because the processing demands for some reports may impact system performance, it may be best to run them at specific times of the day. eThority will distribute reports after midnight, by default. Time is indicative of server time.

**Define Time Constraints:** Click the box to set run times.

**Anytime After:** Click this to specify a time to begin processing.

**But not After:** Click here to prevent the process from beginning if it has not yet done so by the time specified here.
The Graph Tab

Create a Graph
Format a Graph
Create a Graph

To create a Graph, you must first have at least one group and at least one measured column that you wish to compare. The first group will make up the default x-axis in a line or bar graph, or the wedges in a pie chart.

In this example:
The Department and Account Description column are grouped. Department will be the default x-axis or the wedges in a pie chart.
The Reference Number column is Counted and the Actual Amount column is Summed and the Actual Avg Amount is Averaged. These are the values that may be compared and measured in the graph.

The DataBook displays, by department and selected Account, the total number of transactions, the total of dollars spent per account and the average dollars spent per account.
Create a Graph

Click the Graph tab to view the graph. Use the tools to format the graph.
Format a Graph

First select the type of graph from a long list of graphing formats.
Format a Graph

Next from the **Measure** dropdown, select from the Measured column(s) of the DataBook to be compared in the graph. Select a single measure, click on multiple measures, or click the **Browse All Measures** button to view all.
Format a Graph

From here there are numerous options for revising your graph in terms of color schemes, appearance and labeling.

**Legend**

**Legend:** Uncheck the box to hide the legend from view.

**Text:** Click the color box to change the color of the text.

**Background:** Click the color box to change the Legend’s background color.

**Size:** Adjust the size of the font within the Legend.

**Width:** Adjust the width of the legend box to accommodate the values.
Format a Graph

Label

**Name, % and Value:** Check any combination of these check boxes to display the desired label.

**Text:** Click the color box to change the color of the label text.

**Background:** Click the color box to change the labels background color when **Show** is checked.

**Size:** Adjust the size of the font within the label.

**Show:** Show an outline with the selected background color.
Format a Graph

**Title**

**Auto-title:** Click to use the default title generated by the DataBook.

**Custom Title:** Enter a new title for the graph.

**Text:** Click the color box to change the color of the title text.

**Background:** Click the color box to change the title’s background color when **Show** is checked.

**Size:** Adjust the size of the font within the title.

**Show:** Show an outline with selected background color.
Format a Graph

**Style**

**Drop Shadow:** Click to place a shadow behind the graph so that it appears to be floating.

**Reflection:** Click to give the graph a glossy reflection.

**Gradient:** Click to shade the graph and increase the 3D appearance.

**2D:** Click to remove all 3D effects from the graph.

**Background:** Click to place color behind the graph. Click the color box to change the background color.

**Outline:** Click to outline each piece of the graph. Click the color box to adjust the color.
Format a Graph

**Palette**

**Palette:** Select a color theme from the dropdown menu. Select Generate Random Colors for a new color theme every time.

**Data**

**Max Groups:** Enter the total number of groups to be displayed in the graph. The graph supports a maximum of 100 groups. All groups outside the number selected for display will be aggregated into an “Other” column.

**Sort Groups By:** eThority will automatically arrange your graph alphabetically by group title. To change the sort, select the appropriate option from the drop-down menu.
Format a Graph

**Rotate:** Click the Rotate button and move the mouse over the graph to change the presentation angle.

**Zoom In/Out:** Click to enlarge or shrink the graph.

**Reset:** Click to reset the graph back to the default presentation of the graph. This includes all options – legend, label, title, style palette and data.
Graph Drilldown from Pie

Double click on a piece of the pie to drill down to the next level of detail.

In this example, the first level graph displays Amount by Department. Drilling down on a department piece (00411) discloses the amount per account spent by that department.
Graph Drilldown to DataBook

Double click any element of a graph to create a line to the **Create New Databook** icon. You may also drag the mouse from the element to the icon to create the connection. Click the **New** button and a new DataBook is created based on the elements selected.

The filters on the new DataBook are locked down to maintain integrity with the graph. However, the DataBook may be saved as a new DataBook for further manipulation.
Apply **Stick Notes** to add detail and context to charts. Click once on any graph element and the Stick Note Dialogue will appear. Enter note into the white box.

Click the **Trashcan** icon to delete a note.

Click the **Calendar** icon to set options.

From the **Note Expires** dropdown, select one of the following:

**Never**: Stick Note will remain in graph until it is manually deleted.

**When source data is updated**: When new data is imported the note will expire.

**On a specific date**: A date box is presented for expiration date selection.

Click the **Apply to all Notes on Graph** checkbox to make your selections on expiration the default for this graph.
The SuperPivot Tab

Create a SuperPivot
Use the SuperPivot
Create a SuperPivot

To view the data as a SuperPivot, you must first have at least two groups and at least one column with a Measure. In this example, the Actual Amount and the Account Description column are grouped. The Actual Amount column is **Summed**.

This DataBook displays, for each of our departments, the actual amount for travel.
View SuperPivot

Click the SuperPivot tab to view the DataBook as a cross tab report. The first group on the Data tab will be the vertical fields. The second group will be the horizontal fields.

To reverse the axis of the pivot, click the **Swap** button in the upper left.
View SuperPivot

Double click in any cell of the SuperPivot to drilldown to a new DataBook based on the data

Click **File** and **Print** to print a SuperPivot report.
The eValuate Tab

eValuate
Trending
Histogram
The following sample data is taken from baseball statistics from the years 1990 - 1999. To evaluate one of players against the others, highlight the desired row of data, then click the eValuate tab. The selected row of data will be broken down into individual columns, and ranked.
In this example, we can see the comparison of Mark Johnson to the rest of the players. His salary is within the 42 percentile. His wins and losses are a little higher than average.
eValuate

Simply click, drag and drop to see the other Measured fields from the Databook.
eValuate

Right click the gauge to see more detail.
eValuate - Trending

Click the trend button to view an analysis of the salary trend.

Click the Forecast Range to see a projection of the salary if Mark continues to win according the current trend.
eValuate - Histogram

Click the **Histogram** button to view the Distribution of “Wins” Data chart. This illustrates where Mark stands in relationship to the other players.
Dash

Interact
Add
Edit
eXcerpts
Dash - Interact

A Dash is an interactive, highly customizable dashboard for at-a-glance updates on key metrics.

Double click a Dash icon to view and interact with the dashboard.
Dash - Interact

Click the Play Briefing for an audio visual description of the elements of the Dash.
Dash - Interact

Click on any element of the Dash to interact as you would with a DataBook
Dash - Add

To add a new Dash layout, click the button in the center of the Dash panel.

You can also create a new Dash from the menu bar of the eThority home page by clicking Configure / Data Architecture / Create a Dash.
Dash - Add

Click **Add Element** to add an eXcerpt from the Element Catalog dialog box. See Dash eXcerpt for information on adding a new eXcerpt to the catalog.
Dash - Add

There are several ways to find your eXcerpt. You can use the Quick Filter in upper left to limit your selection to a specific type or types of eXcerpt. You can use the Search feature in the upper right or you can filter by Keyword in the lower left.

Select one or more eXcerpt types from which to choose.

Click the Filter by Keyword check box and select a keyword.

Enter a search value and click Go. The grid will be limited to eXcerpts containing the search value in any column.
Dash - Add

Select an element in the catalog and click the Preview button to verify your selection before adding it to the Dash.
Dash - Add

Select your element from the catalog and click **OK**. The first element is added to the panel. Click **Add Element** again to continue adding new eXcerpts to your Dash.

When adding multiple Alert Metrics you are given the option to keep all metrics on a single panel or create a new panel.
Dash – Edit

To edit your Dash, click the **Edit** button in the upper right of your Dash panel. To edit the properties of an element within your Dash, click on the element and then the **Edit Element** button. When your changes are complete, click the **Save** button.

Set properties specific to each type of element
Dash - Edit

For Alert Metrics, the Properties dialog box allows you to specify the details of the alert.

**Min / Max:** Set the minimum and maximum limits of the alert.

**Trigger:** In each trigger field enter the limit considered appropriate for the level of alert.

**Color Box:** Change the color progression.

**Show Alert:** Click to display Color Alert circle.

Scroll to edit Trigger properties.
Dash - Save

To save your Dash, click the Dashboard Properties button. Click the **Sharing** button to determine who will have access to this Dash.

**REMEMBER**  It is only the shaping and format of the Dash that is shared. The content is based on the user rights – organizationally and through assignment of roles.

**Name:** Enter the Dash name to be displayed in the Library.

**Description:** Include a brief summary of your Dash in this field if desired.

**Global:** The Dash will be available to all eThority users.

**Department:** Specify an area within the organizational structure to have access to this Dash.

**User:** Select specific users or groups of users who can access to this Dash.
**Dash - Save**

**Keywords** allows you to assign keywords to your Dash for use in future searches. Double click on a keyword from the dictionary or highlight and click the **Add** button.

To add a new keyword, click **New Keyword** button.

The Keywords dialog is displayed. Click **Add** and enter your new keyword and description. Click **Save**.

Your new keyword is now an option in the Keyword Dictionary.
Dash - Save

Click the **Author/Notes** button to add comments pertaining to this version of the Dash. Share specific details of the Dash to share with other users.

Add a date to your notes by clicking the **Data Stamp** button. This will provide context for your comment, particularly in a Dash where the data is updated frequently.
Create your graph. From the File menu option, click Create Graph eXcerpt. Enter the name and description of the eXcerpt. Select Sharing options, Keywords and enter Notes as needed.
Create your DataBook. From the File menu option, click Create Table eXcerpt. Enter the name and description of the eXcerpt.

Select Sharing options, Keywords and enter Notes as needed.
Dash – Metric eXcerpt

To create a Metric Alert, first create a DataBook with at least one group and apply a Measure to one or more columns. Right click a row in the column for which you would like an alert. Click **Create Metric eXcerpt** to open the Create Metric eXcerpt dialog.
Dash – Metric Alert

Min / Max: Set the minimum and maximum limits of the alert.

Color Box: Change the color progression.

Show Alert: Click to display Color Alert circle.

Scroll to enter the Trigger properties.

Value: For each trigger, enter the limit considered appropriate for the level of alert.

eXpression: Create a calculation on which to base the trigger value.

When: From the dropdown select Falls Below Trigger, Passes Trigger or Exceeds Trigger as appropriate.

Send e-mail: Check to have an e-mail automatically sent to the address in the To field when a trigger has been met.